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UM2177
User manual

PC software for the ST25R3911B-DISCO kit 

Introduction

The ST25R3911B-DISCO GUI (STSW-ST25R001) is a PC software application, which 
allows the user to configure, evaluate, and communicate with the ST25R3911B high 
performance HF reader / NFC initiator.

The software must be used in conjunction with the ST25R3911B-DISCO kit, which includes 
a ready-to-use board to interface with the host PC through a USB interface. This software 
allows the evaluation of every feature of the ST25R3911B. The ST25R3911B communicates 
with the STM32L476 32-bit core MCU via the SPI bus.

The ST25R3911B-DISCO board is powered through the USB port, and no external power 
supply is required. It includes an ST25R3911B high performance HF reader / NFC initiator, 
an etched antenna, and the associated tuning components.

Starting with version 1.1.0 the ST25 Tag Editor is included, which allows access to all 
features of ST25 Tag and Dynamic Tags series.

www.st.com

http://www.st.com
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1 List of acronyms

          

Table 1. List of acronyms 

Acronyms Description

CW Continuous wave

DFU Device Firmware Upgrade

FeliCa Contactless RFID smart card system from Sony

GUI Graphical User Interface

HID Human Interface Device class

ISO14443-A
Technology A of international standard that defines proximity cards 
used for identification.

ISO14443-B
Technology B of international standard that defines proximity cards 
used for identification.

ISO15693
ISO standard for vicinity cards. These cards can be read from a greater 
distance compared to proximity cards

PUPI Pseudo Unique Identifier

UID Unique Identifier

USB Universal Serial Bus

VICC Vicinity Integrated Circuit Card according to ISO 15693. 
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2 ST25R3911B-DISCO demo kit

This section describes the USB driver installation, and the GUI (Graphical User Interface) 
software for communication between the PC and the ST25R3911B-DISCO board.

2.1 ST25R3911B-DISCO board installation

To install the ST25R3911B-DISCO board, connect it to a PC with a USB cable to a USB port 
that is capable to deliver more than 250 mA of current. Usually, this kind of port is on a 
powered USB Hub or directly on a PC.

2.2 Installing the ST25R3911B-DISCO PC software 
(STSW-ST25R001)

To install the ST25R3911B-DISCO development software (STSW-ST25R001):

• Download the latest version of the ST25R3911B-DISCO development software from 
www.st.com.

• Execute the installer and follow the GUI install procedure.

When the installation process is complete, the ST25R3911B-DISCO development software 
can be used.

Note: The ST25R3911B-DISCO board works using USB HID (Human Interface device class). 
There are no special ST25R3911B-DISCO drivers. Windows® uses stack mouse and 
keyboard drivers.
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2.3 Firmware update

The ST25R3911B-DISCO demo kit contains a DFU driver, and it is required to update the 
firmware before using the STSW-ST25R001. 

Open the GUI and select “Firmware update:

1. Select in the menu “Help” the entry “Firmware Update”. A file chooser opens, there 
choose the “DISCO_STM32L4x6.hex”. If the DFU driver is already installed the 
firmware update should finish in few seconds, otherwise go to point 2. 

2. If the DFU driver is not installed, open the “Device Manager” window (no need to wait 
for the GUI’s feedback):

a) Select under “Other devices” the “STM32 BOOTLOADER” 

b) Click on right button of the mouse and select “Update driver software (See 
Figure 1)

Figure 1. Device Manager window

c) Select “Browse my Computer for driver software”

d) Enter “C:\Program Files 
(x86)\STMicroelectronics\ST25R3911B_Discovery_GUI\Driver” and install it. 

e) Under “Universal Serial Bus controllers” appears an STM Device in DFU Mode. 
(See Figure 2)
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Figure 2. STM Device in DFU Mode

f) In the meantime the ST25R3911B-DISCO GUI is in timeout, and the USB field in 
the status bar is red.

g) To do the update, restart from point 1

Caution: The loading of a wrong firmware makes the board unusable, but the board can be 
automatically enumerated as an STM Device in DFU Mode forcing the bootloader by 
pressing the Boot button on the board, holding it and then connecting the USB. 



DocID030328 Rev 2 11/87

UM2177 ST25R3911B-DISCO demo kit

27

2.4 ST25R3911B Discovery GUI tab

If the software package is installed correctly, and the ST25R3911B-DISCO board is 
connected to PC USB port, the main menu is displayed (see Figure 3). The toolbar also 
contains the ST25 Tag Editor icon, which allows the ST25 Tags editing. To open it, click on 
the ST25 Tag Editor icon, while a board is connected. The Disco GUI will automatically 
disconnect from the board, and open the ST25 Tag Editor to take control over the board. To 
go back to the Disco Reader functionality, just close the ST25 Tag Editor or click on the icon 
again. The ST25 Tag Editor will be closed automatically in this latter case.

Please see Section 3: Using the ST25 Tag Editor software for details.

Note: The firmware version number is shown in the status bar of the main window.

This tab allows the user to access several sub-menu:

• StartUp tab (see Section 2.4.1)

• Antenna features tab (see Section 2.4.2)

• Wakeup tab (see Section 2.4.3)

• Polling tab (see Section 2.4.4)

• NFCIP tab (see Section 2.4.5)

• ISO 14443A tab (see Section 2.4.6)

• ISO 14443B tab (see Section 2.4.7)

• ISO 15693 tab (see Section 2.4.8)

• FeliCa tab (see Section 2.4.9)

• NFC Type 1 tab (see Section 2.4.10)

• NFC Type 2 tab (see Section 2.4.11)

• Debug tab (see Section 2.4.12)

• Dynamic Config tab (see Section 2.4.13)
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2.4.1 StartUp tab

Figure 3 shows the startup tab. 

The status tab on the bottom right corner shows the connection status. If the HW is 
successfully connected via USB then the status turns to green, and displays the version of 
the Firmware.

Figure 3. GUI startup

• Click on “Demo Board Check” button. This action checks the USB connection to the 
demo board, and reads some demo board information, which is required for the GUI 
operation. The configuration of the ST25R3911B is based on this information. 

• Click on “Adjust Regulators” button to automatically set the regulators. This command 
improves the system Power Supply Rejection Ratio, and the value of regulated voltage 
is displayed.

• Click on “Calibrate Antenna” button. This command automatically adjusts the 
resonance frequency of the antenna LC tank. It has to be run again in case the 
environment of antenna coil is changed (for example in case that some metal object is 
placed near to the antenna).

• Antenna trimming OK is displayed next to the button.

When the Start-up procedure is done, the user can proceed with using the other tabs.
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2.4.2 Antenna features tab 

Figure 4 shows the Antenna features tab. 

Figure 4. Antenna features tab

• The antenna resonates at 13,56MHz, when the pointer shows maximum input signal 
amplitude. 

• Choose a target phase to use it as a reference for the software algorithm.

• Click on “Measure Antenna” button to measure the amplitude of the input signals and 
the phase differences between output and input signal. Both are displayed on the 
graph and the command line on the bottom. 

The input amplitude and phase difference can be continuously monitored by using the 
“Continuous Measurement” button. Moreover, when this option is activated and a piece of 
metal is approached to the antenna, a detuning effect can be seen.

The “Auto Adjust Antenna” button allows the antenna tuning. This action can be done 
continuously by pressing the “Continuous Adjust Antenna” button. 

Moreover, it is possible to manually adjust the trim value with the List Box “Trimming 
values”. It is recommended to use the “Continuous Measurement” for this investigation. 

Note: The antenna feature menu can be easily used for matching network evaluation of others 
ST25R3911B based readers. 
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2.4.3 Wakeup tab

The ST25R3911B offers three wakeup modes (capacitive, inductive (phase) and inductive 
(amplitude) that generate an interrupt to a microcontroller in some sleep mode. 

Note: This demonstrator is for evaluation purposes, there are continuous measurements updates 
happening, which result in extra current consumption.  
The “read at interrupt only” switch avoids interaction and minimizes the current.

Capacitive wakeup 

Figure 5 shows the wakeup window with the capacitive wakeup enabled. 

Figure 5.  Wakeup window - Capacitive wakeup enabled

This method allows to measure the capacitance across two electrodes. 

• Click on “AutoCalibrate” button to do the calibration and to remove the parasitic 
capacitances influence. Alternatively, it is possible to manually set the calibration value. 

Note: The “AutoCalibrate” button only works if the calibration value is set to “Auto”. 

• Click on “Measure” and “Measurement to Offset” button to set the initial status (Offset).

• Click on “Start” button to initiate the autonomous wake up mode of ST25R3911B.

The obtained measurement values are shown in Figure 5. 

Note: Each interrupt is indicated by a red dot. 
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Other additional parameters are: 

• Delta (window size) defines the window in which no interrupt is generated. If the 
actual measured value is within the window range, no interrupt will be generated.

• Timer period defines how often the measurement procedure is executed.

• Automatic averaging box selects an automatic or static offset value. In case of an 
auto averaging, the offset is dynamically adjusted to the environment condition. If this 
option is active, the offset changes dynamically with a weighted factor which can be 
selected. The weight option defines how fast the offset value is being adapted to the 
new environment condition. 

Inductive wakeup 

The inductive wakeup scans periodically the input signal amplitude and the phase difference 
of the output and input signal. If there is a change of one of these two antenna tuning 
parameters an interrupt is generated. 

The antenna needs to be tuned before starting the inductive wakeup procedure. 

Figure 6. Wakeup window - Inductive (phase) wakeup enabled

Figure 6 shows the wakeup window with the phase differences measurement enabled. 

To achieve the offset level, it needs to execute the same procedure of Capacitive wakeup.

Figure 7 shows the wakeup window with the input signal amplitude measurement.
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Figure 7. Wakeup window - Inductive (amplitude) wakeup enabled

Note: Different wakeup ranges can be achieved with the phase or amplitude method. This 
depends on the antenna matching network. 

2.4.4 Polling tab

Figure 8 shows the anti-collision and multi-protocol features of ST25R3911B-DISCO board. 

In addition to the protocols shown, the following protocols are supported:

• Kovio Barcode 128/256 bit (ISO 14443A checkbox)

• iCLASS (ISO 15693 checkbox)
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Figure 8. Polling tab

By default all standards are active.

• Click on the “Find” button. The reader starts to scan for tags that are in the proximity of 
the reader. 

• The polling process stops if clicked on “Stop” button during the polling process.

• The screen log shows the UIDs or PUPIs, the type and how often the tag is detected.

• The time stamp shows the time of the last detection. 
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2.4.5 NFCIP tab 

Figure 9 shows the NFCIP tab, which displays the peer-to-peer functionality of the 
ST25R3911B. 

Figure 9. NFCIP window

Note: This feature requires an NFC enabled device supporting peer to peer protocol.

The ST25R3911B is initially configured to cycle through the initiator and target mode. The 
default setting for the bit-rate is 424kbps. 

The communication starts automatically when the tab is selected. 

Once the link is established, the initial gray phone picture on the GUI is replaced by a 
colored one. 

When the connection is established it is possible to transfer an URL to the phone:

• Write the URL and click on “=URL =>” button to start the transfer.

• The browser of the phone opens the requested URL. 

It is possible to transfer pictures to the phone (The GUI provides three samples as 
example): 

• The “Image from Disk” button provides an individual option to select a file. 

– Click on one picture to start the transfer. The picture’s transfer takes several 
seconds, because the picture contains a large amount of data. For this reason, 
please wait until the picture is transferred. 

– The phone will display the received picture with the comment “new Tag received”.
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2.4.6 ISO 14443A tab 

Figure 10 shows the ISO 14443A tab.

Figure 10. ISO 14443A tab

The “Configuration” button prepares the board for ISO 14443-A communication, and the 
following sequence activates the cards:

• “REQA ->Active” or “WUPA ->Active” starts the anti-collision procedure

• Tag UID is displayed. 

• If the card/tag supports ISO 14443-4 then additional commands like RATS or PPS can 
be carried out. 

• Click on RATS or PPS. 

• Send arbitrary frames using “Debug” tab (See Section 2.4.12: Debug tab)
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2.4.7 ISO 14443B tab

Figure 11 shows the ISO 14443B tab.

Figure 11. ISO 14443B tab

The “Configuration” button prepares the board for ISO 14443-B communication, and the 
following sequence activates the card:

• Click on “REQB” or “WUPB” button to poll once. The PUPI of a found tag will be 
displayed.

• If the card/tag supports ISO 14443-4 then additional commands like “ATTRIB” can be 
carried out.

• Send an arbitrary frames using “Debug” tab (See Section 2.4.12: Debug tab)
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2.4.8 ISO 15693 tab 

Figure 12 shows the ISO 15963 tab.

Figure 12. ISO 15693 tab

The “Configuration” button prepares the board for ISO 15693 communication, and the 
following sequence activates multiple cards:

• Click on “Configuration” button

• Set the ISO 15693 parameter to receive data rate, and the number of slots, which are 
used in the anti-collision loop in the firmware.

• Click on “Inventory” button to scan for Vicinity Integrated Circuit Cards. 

• Select one of found UIDs using the drop-down box. Now the “Get System Information 
button” can be pressed to retrieve more information about the selected card. 

The “Get System Information” will request the card for supported features. The command 
“Read blocks” will read out and display the memory blocks of the card. 

Note: Not all vicinity cards support “Get System Information” command.
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2.4.9 FeliCa tab 

Figure 13 shows the FeliCa tab. 

Figure 13. FeliCa tab

The “Configuration” button prepares the board for FeliCa communication, and the following 
sequence activates a card:

• Set the number of slots used in the anti-collision 

• Click on “Poll” button to poll once for FeliCa cards.

• Arbitrary FeliCa commands can be executed using the “FeliCa Card Commands”. The 
IDm will be inserted on request.
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2.4.10 NFC Type 1 tab 

Figure 14 shows the NFC Type 1 tab. 

Figure 14. NFC Type 1 tab

The “Configuration” button prepares the board for NFC Type 1 communication, and the 
following sequence activates a card:

• Click on “Select” button to send a WUPA. The UID of the Type 1 Tag is shown.

• The commands read and write are available, and it is possible to read and write its 
memory blocks. 
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2.4.11 NFC type 2 tab 

Figure 15 shows the NFC type 2 tab.

Figure 15. NFC type 2 tab

The “configuration” button prepares the board for ISO 14443A communication and enables 
the field. 

Read data from page sequence:

• Click on “Configuration” button.

• Click on “WUPA->Active” to find a cards.

• Activate the “READ Data from Page” flag 

• Click on “Execute” to read the memory card content

Write data from page sequence:

• Click on “Configuration” button.

• Click on “WUPA->Active” to find a card.

• Activate the “WRITE Data from Page” flag 

• Click on “Execute” to write the memory card content

The Lock page: 

• Click on “Configuration” button.

• Click on “WUPA->Active” to find a card.

• Activate the “LOCK Page” flag 

• Click on “Execute” to lock the memory card page content
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2.4.12 Debug tab

The debug tab is split into two group boxes (see Figure 16): 

• “Send Direct Command” allows sending ST25R3911B direct commands.

• “TxRxNBytes” allows to send the arbitrary hex-encoded byte strings, with the 
previously selected protocol, directly through the FIFO. 

Note: This is not possible for ISO15693 since for this protocol the firmware has to do the bit 
coding.

Figure 16. Debug tab

Note: The usage of this tab is for experienced users only. 
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2.4.13 Dynamic configuration tab

The dynamic configuration tab is a powerful instrument to fine-tune the settings of every 
technology and bit rate. 

Figure 17. Dynamic configuration tab

Elements:

• Read from board: Replace the current configuration with the one from the board.

• Write to board: Apply the current configuration on the board. It will be stored in RAM 
only, and a reset erases it.

• Save to File: Write the settings as an XML to your computer. 

• Load From File: Read an existing XML from your computer.

• Generate Code: Generate the table as C-Code to be included in user source code.

• Mode group:

– Every operation mode of ST25R3911B has a corresponding mode ID.  
The drop down box allows you to select the pre-defined modes, and add them to 
the listed modes.

– It is also possible to define your own modes with own mode IDs but these may not 
be used by the firmware. Be careful to do that only if you know what you are doing.

• Functions group: 
Every mode has associated one or more functions. A function can be:

– Selected from drop down box

– Defined by user. In this case it can be defined as triples of register address + 
register mask + register value. All named functions will just be translated into 
these register mark value. 

If the new function is added to only one of the modes, it will be applied when this mode 
is selected, but it will not be reset to its initial state after leaving this mode. To be 
available to all modes, it must be added to all modes on the same level.

Note: The default configuration works in most cases.
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2.5 Register Map

The GUI includes a register map window showing the registers of ST25R3911B. 

Figure 18. Register map

This window can be opened by clicking the “Register Map” button in the toolbar, selecting 
the “View->Register Map” menu entry or pressing “Ctrl-M”. 

Typically, the display of the registers is in hex but can also be changed to decimal. Hovering 
over the icon “bits” opens up a tool tip showing details of the bit/bit fields.

Clicking bits will toggle the bits and entering a value without “0x” into the Value column will 
allow changing complete registers.

The update of the register map can be manually triggered (“File->Readout Registers”), or be 
done automatically (“Settings->Automatic Update”).
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3 Using the ST25 Tag Editor software

When the ST25 Tag Editor software is launched, a detection process begins (see Figure 19 
and Figure 20) to check:

• the revision of the DLL installed on your computer

• the revision of the ST25R3911B-DISCO’s firmware

• the ST25R3911B-DISCO’s hardware name

The objective of these checks is to verify that the DLLs installed on your PC is up-to-date, 
and aligned with the firmware revision of the ST25R3911B-DISCO.

If a problem occurs during the detection, the message shown in Figure 21 is displayed.

Figure 19. Detection message 1/3
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Figure 20. Detection message 2/3

Figure 21. Detection message 3/3
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3.1 Main menu

If the software package has been installed correctly and the ST25R3911B-DISCO board is 
connected to PC USB port, the main menu appears.

This menu allows the user to access several sub-menus:

• ISO15693 mode (see Section 3.2)

• ISO14443-A mode (see Section 3.3)

• ISO14443-B mode (see Section 3.4)

• ISO18092 mode (see Section 3.5)

• Tools menu (see Section 3.6)

• Help menu (see Section 3.7)

Figure 22. Main menu
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3.2 ISO15693 menu

1. Select ISO15693 from the main menu to use the ST25R3911B-DISCO as an ISO15693 
reader (see Figure 23).  
The menu allows to select:

• NFC/RFID TAGS 

– LRI1K

– LRI2K

– LRIS2K

– LRIS64K

• DYNAMIC NFC TAGS

– M24LR64

– M24LR04E

– M24LR16E

– M24LR64E

– ST25DV04K

– ST25DV16K

– ST25DV64K

• OTHERS

– PICOPASS

• NDEF Management

– Vicinity Tags - NDEF message user interface

– NFC Type 5 - NDEF message user interface

Figure 23. ISO15693 menu

2. EXAMPLE 1: M24LR64E USER INTERFACE 
Select a device from the list (see Figure 24 for an example). The board is then 
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automatically configured as an ISO15693 reader, and the ST25R3911B-DISCO can 
send/receive ISO15693 frames to/from the tags using the SendRecv command. 

ISO15693 communications are configured as follows:

– 100% high data rate

– One subcarrier

The ISO15693 configuration is displayed in the log window.

The upper part of the menu shows buttons which allow to send ISO15693 requests to a 
tag through the ST25R3911B-DISCO antenna. The main available requests are:

– Inventory

– Select

– Stay Quiet

– Reset to ready

– Get system info

– Initiate

– Inventory initiated

– Fast initiate

– Fast Inventory initiated

By default, the ISO15693 requests are sent in Non-selected/Non-addressed mode, and 
the requests are decoded by all the tags present in the RF field. 

To switch to Addressed mode, follow the steps below: 

a) Send an Inventory request to retrieve the tag UID.

b) Click on the UID displayed in the INVENTORY response window to automatically 
copy the UID into the Tag information text box. 

c) Check Address Flag to activate the Addressed mode for the coming requests.

The following sequence is required to switch to Selected mode:

a) Send a Select request in Addressed mode (steps a to c above).

b) Uncheck Address Flag.

c) Check Select Flag.

All the coming requests will be sent to the previously selected tag. 
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Figure 24. Example of ISO15693 user interface for M24LR64

3. Click User Mode from the toolbar of the device ISO15693 user interface to display the 
ISO15693 requests that can be sent in User mode (see Figure 25). The main requests 
are:

– Read single and multiple block(s) 

– Fast read single and multiple block(s)

The ST25R3911B-DISCO is automatically configured in Fast mode, and put back 
in normal mode when the request is complete.

Other requests are available (DSFID, AFI, ..). Refer to the device datasheet for the full 
list of ISO15693 requests available for a given product. 

Note: The tag answer to a read request is displayed in the right part of the window.
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Figure 25. Selecting User Mode from ISO15693 user interface

4. EXAMPLE 2 : ST25DV64K USER INTERFACE. 
A specific user interface has been build in order to be able to use ST25DV products. 
This user interface allows to manage all the features of the ST25DV : 

– INVENTORY 

– EEPROM 

– FTM (FAST TRANSFER MODE)

– CONFIGURATION 

– PASSWORD 

– ENERGY HARVESTING 

– DEMOS

a) INVENTORY & ANTICOLLISION COMMANDS 
This part of the user interface allows the user to send Inventory commands and 
manage ISO15693 states:

– Inventory

– Select

– Stay Quiet

– Reset to Ready

– Anticollision button will allow to launch global antcollision process manage by the 
STM32 and display up to 5 UID's tags.
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Figure 26. ST25DV user interface: Inventory

b) AFI, DSFID & SYSTEM INFO COMMANDS (see Figure 27):

– Write DSFID

– LOCK DSFID

– Write AFI

– LOCK AFI

– Get System Info

– Extended Get System Info
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Figure 27. ST25DV user interface: AFI DSFID INFO

c) EEPROM commands (see Figure 28):

– Read Single Block

– Write Single Block

– Read Multiple Blocks

– Write Multiple Block

– Get N BSS

– Lock Block (block 0 or Block 1)
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Figure 28. ST25DV user interface: EEPROM

To be able to access to Extended commands, the user will need to click on "Extended 
commands" check box (see Figure 29).

Figure 29. ST25DV user interface: display Extended commands

To be able to access to Fast commands, the user will need to click on "Fast data rate" check 
box.
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d) CONFIGURATION commands:

– Read CONFIG bytes

– Write CONFIG bytes

Figure 30. ST25DV user interface: static configuration
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e) FTM commands (see Figure 31):

– Read Len

– Read Message 

– Write Message

– Read DYNAMIC register

– Write DYNAMIC register

Figure 31. ST25DV user interface: Fast Transfer Mode interface
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f) PASSWORD commands (se Figure 32):

– Present Password

– Write Password

Figure 32. ST25DV user interface: Password management
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g) ENERGY HARVESTING & GPO commands

– Read DYNAMIC register

– WRITE DYNAMIC register

– Send Interrupt

– Set GPO

– Reset GPO

Figure 33. ST25DV user interface: Energy Harvesting and GPO management
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h) DEMOS (see Figure 34). 
This demos can be played with ST25DV-DISCOVERY boards. 
Refers to user manual UM2062 for more informations about this demos.

Figure 34. ST25DV user interface: Fast Transfer Mode demo
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5. NFC type 5: NDEF Message User Interface.

a) READ & WRITE CC file (see Figure 35)

– Read CC File

– Write CC File

Figure 35. Read and write NFC Type 5 CC file

b) READ NDEF MESSAGE
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Figure 36. Read NFC Type 5 NDEF message
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c) PREPARE NDEF MESSAGE 
Use User interface to prepare your NDEF message by selecting one of the NDEF 
recrd format (Text, Uri, Smartposter, vcard, Bluetooth pairing). 
Click on ADD RECORD TO MESSAGE button, will add the record in the NDEF 
message. 

Figure 37. Prepare NFC Type 5 NDEF message
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d) WRITE NDEF MESSAGE 
The prepared NDEF MESSAGE with embedded NDEF records is displayed. 
If you need to change anything on the NDEF MESSAGE, click on Clear and go 
back to PREPARE NDEF MESSAGE to create a new one. 
Click on WRITE NDEF MESSAGE to write the NDEF message to the NFC Tag.

Figure 38. Write NFC Type 5 NDEF message
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3.3 ISO14443-A menu

Select the ISO14443-A from the main menu to use the ST25R3911B-DISCO as an 
ISO14443-A reader. The menu allows to select:

– ISO14443-A cards commands

– M24SR products

– ST25TA Tags

– Password management for M24SR & ST25TA

– NFC Type 2A & 4A NDEF Messages management

– ISO14443-A Cards commands: (see Section 3.3.1). 
This menu allows the user to send any ISO14443-A requests

– M24SR02, M24SR04, M24SR16, M24SR64 (see Section 3.3.2). 
This menu allows the user to send any ISO14443-A requests or APDU request to 
M24SR product

– NFC Type_4A NDEF Message user interface (see Section 3.3.4). 
This menu allows the user to read and write NDEF message to Tag Type 4A

– SRTAG2K-D, ST25TA16K, ST25TA64K (see Section 3.3.2). 
This menu allows the user to send any ISO14443-A requests or APDU request to 
SRTAG product.

– ST25TA512, ST25TA02K, ST25AT02K-D, ST25TA02K-P (see Section 3.3.2). 
This menu allows the user to send any ISO14443-A requests or APDU request to 
ST25TA product. 

– Password management for M24SR & SRTAG products (see Section 3.3.3). 
This menu allows the user to manage password and access rights on M24SR and 
SRTAG products

Figure 39. ISO14443-A menu
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3.3.1 ISO14443-A Cards commands

Select ISO14443-A from the list (see Figure 40 for an example). This automatically 
configures the ST25R3911B-DISCO as an ISO14443-A reader and displays all the 
ISO14443-A requests.

Figure 40. ISO14443-A selected from the list

The ISO14443-A configuration is displayed in the log window as shown in Figure 40.

The upper part of the window contains buttons allowing to send ISO14443-A requests to 
tags through the ST25R3911B-DISCO.

Refer to the device datasheet for the full list of ISO14443-A requests available for a given 
product.

Anticollision process will try to communicate with your Tag and try to select it. This automatic 
process is only for 1 tag.

It sends successively: 

• ReqA

• Anticol1

• Select1

• Anticol2

• Select2

• Anticol3

• Select3
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The process will be stopped as soon as an error occurs or if the anticollision process is 
finished (4 bytes or 7 bytes or 10 bytes UID).

Other commands can be sent such as:

• RATS

• PPS 

• READ

• WRITE

Send Receive APDU can be used to send APDU requests.

3.3.2 M24SR, SRTAG and ST25TA user interface

The selected product user interface has been separated into two different windows to 
improve the visibility of the tool. 

We have separated this two windows following the “life” of the selected product (see 
Figure 41): 

– after a RF POR or a deselect command, the selected product is in the ISO14443-
A world 

– after RATS or PPS command, the selected product enter in the NFC world.

First, selected product among the liost of products (M24SR, SRTAG, ST25TA).

When selecting the device, the ISO14443-A window appears.

Figure 41. M24SR user interface
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As soon as the windows appears, the ISO14443-A protocol selection is done in background.

Click on show log to display the log window and see the ST25R3911B-DISCO protocol 
selection sequence (see Figure 42)

Figure 42. ST25R3911B protocol selection sequence

ISO1443-A screen

The first screen (see Figure 41) is displayed when the M24SR is selected in the option 
menu. Several buttons are displayed in this window. The buttons represent all the available 
commands in the ISO14443-A world:

Some buttons are used to send single commands: 

• SENS REQ (REQA): send a REQA to the M24SR

• ALL REQ (WUPA): send WPUA command to the M24SR

• SLP REQ (HLTA): send HLTA command to the M24SR

• SDD REQ 1 2 3 (ANTICOL 1 2 3): send Anticol command to the M24SR

• SEL REQ 1 2 3 (SELECT 1 2 3): send Select command to the M24SR

• RATS: send RATS command to the M24SR

• PPS: send PPS command to the M24SR

• DESELECT: send Deselect command to the M24SR

Two additional buttons allow to accelerate the communication with the M24SR:

• Anticollision Process button 
can be used to detect a Tag and read the UID of this tag 
when clicking on this button, the anticollision sequence is sent (beginning by a REQA 
or WUPA) depending of the Option button. 
The REQA/WUPA answer is detailled in SENS REQ answer screen. 
The anticollision sequence is summarized in the array. 
The sequence is launched and stopped when an error occurred. 
At the end of the sequence, if no error is found, the UID of the selected M24SR is 
displayed in UID field as show on Figure 43
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Figure 43. Anticollision process results

• RF OFF RF ON ANTICOLLISION RATS PPS button 
can be used  the whole anticollision process with RATS with PPS to reach NFC type 4A 
world. 
This button can be configured by enabling or disabling

• RF OFF/ON 

• Replace REQA command by WUPA command 

• PPS request added to the sequence

Figure 44. RF OFF on anticollision RATS PPS button

The sequence is launched and stopped when an error occurred.

At the end of the sequence, if no error is found,

• The UID of the selected M24SR is displayed in UID field.

• RATS answer

• PPS Answer (if option selected)

• The log windows is filled with RF request & RF answer
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As shown on Figure 45

Figure 45. RF OFF on anticollision RATS PPS results

At the end of this action, if no error is occurred and M2SR answers are Ok, the window will 
automatically switch to the windows called NFC Type 4A.

How to access to ISO14443-A command and NFC Type 4A commands:

– When the ISO14443-A windows is displayed, the “NFC Type 4A” button is 
available to switch to NFC Type 4A window. 
See Figure 46

Figure 46. NFC Type 4A button available 

– When the NFC Type 4A windows is displayed, the ISO14443-A button is available 
to switch to iso14443-A window. 
See Figure 47

Figure 47. ISO14443-A button available

As already explained in the user manual, the “RF request” and “RF answer” fields contains 
the send command and the answer from M24SR.

Figure 48. RF request and RF answer
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The show log button is available to be able to see the history of RF request and RF answer. 
See Figure 49 and Figure 50.

Figure 49. “Show Log” button

Figure 50. Log windows of RF request/answer

The formatted request (ex: ST25R3911B_SENDRECEIVE, 0300B000000FA5A2 08) can be 
used in script tool.

NFC Type 4A screen 

This window will allows to send NFC APDU requests to be able to play with the M24SR tag 
in NFC world (see Figure 51). This window is automatically reached when the "RF OFF RF 
ON ANTICOLLISION RATS PPS" button is used and all the processes are done 
successfully or when the user click on "NFC Type 4A" button.

Figure 51. NFC Type 4A user interface
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The middle part of the window is used to generate the RF frame to be sent to the M24SR: 
I_Block, R_Block, S(DES)_Block and S(WTX)_Block request. 

All this field can be changed by clicking and modifying data

Four buttons are available to send I_Block, R_Block, S_Block requests.

Figure 52. I_Block, R_Block, S_Block requests

The answer of the M24SR is filled in I_Block, R_Block, S_Block answer fields depending on 
the request sent to the M24SR.

Figure 53. I_Block, R_Block, S_Block answer

The higher part of the window can be used to automatically fill the I_Block request.

The goal is to facilitate the communication with the M24SR (following NFC forum and 
M24SR datasheet).

Several option buttons are available:

• NDEF Tag Application select 
When this option is selected, the I_Block frame is filled with adequate data. 
Once the command option is selected, the data in I_Block rf frame are filled, you can 
press the button “send I_Block” to send RF frame.

• Capacity Container file 
Selecting Capacity Container File option will allow other option to appear 
clicking on one of this option will fill, the I_Block frame is filled with adequate data.
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Figure 54. Capacity container file selected

– Select  command: 
fill data with CC file Select command

– Read binary (length) command 
fill data with read binary command on CC file in order to read the length of the cc 
file

– Read binary command 
fill data with read binary command on CC file

Once the command option is selected, the data in I_Block rf frame are filled, you can press 
the button “send I_Block” to send RF frame.

– Select & read sequence button will launch automatically all the procedure and 
will display it in a CC file result window

Select cc file

Read cc file length

Read cc file data

Display data in a specific CC file array (available only of no error detected)

Figure 55. Specific CC file array

• System file 
Selecting System File option will allow other option to appear. 
Clicking on one of this option will fill, the I_Block frame is filled with adequate data.
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Figure 56. System file selected

– Select  command: 
fill data with System file Select command

– Read binary (length) command:  
fill data with read binary command on System file in order to read the length of the 
system file

– Read binary command: 
fill data with read binary command on System file 

– Send Interupt GPO 

– State control: Set GPO

– State control: Reset GPO

Once the command option is selected, the data in I_Block rf frame are filled, you can press 
the button send I_Block to send RF frame.

– Select & read sequence button will launch automatically all the procedure and 
will display it in System file result window
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Select system file

Read sytem file length

Read system file data

Display data in a specific System file array (available only of no error detected)

Figure 57. Specific system file array

• NDEF file 

Selecting NDEF File option will allow other option to appear.

Clicking on one of this option will fill, the I_Block frame is filled with adequate data.

Figure 58. NDF file is selected

– Select command: 
fill data with NDEF file Select command

– Read binary (length) command: 
fill data with read binary command on NDEF file in order to read the length of the 
cc file

– Read binary command 
fill data with read binary command on NDEF file 

– Extended Read binary command 
fill data with extended read binary command on NDEF file 

– Update Binary command 
Fill data with update binary command on NDEF file 
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In case of M24SR request a WTX , this button will automatically manage it. The 
M24SR will reply with a Window Extension request (that will be displayed in 
S(WTX) answer array), then the tool will automatically send a S(WTX) request to 
the M24SR 
All this request / answer communication will be displayed in Log window.

Once the command option is selected, the data in I_Block rf frame are filled, you can press 
the button “send I_Block” to send RF frame.

– Select & read sequence button will launch automatically all the procdure and will 
display it in NDEF file result window (NDEF file can be decoded)

Select NDEF file

Read NDEFfile length

Read NDEF file data

Display binary data in a field (available only if no error detected)

Display decoded NDEF message if any is in a field (available only if no error detected)

Figure 59. Binary data and NDEF message are detected

• Commands to manage Password and Access Rights

Three command can be used to manage Passwords (Read password or Write password).

– Verify (check if password is required) 
fill data with Verify command

– Verify (present password) 
fill data with Verify command

– Change reference data (change password value) 
fill data with Verify command

Note: Notes that a  NDEF file has to be selected previously (see Datasheet) 
The command sent will be applied to selected NDEF file
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Figure 60. Password management button

Three commands can be used to manage Access right and M24SR state (see Figure 60).

– Enable Verification requirement 
fill data with Verify command

– Disable Verification requirement 
fill data with Verify command

– Enable Permanent State 
fill data with Verify command

Note: Notes that a  NDEF file has to be selected previously (see Datasheet) 
The command sent will be applied to selected NDEF file

Figure 61. Password management buttons

NDEF Messages management button

It allows directly access to NFC Type_4A NDEF Message user interface (see Section 3.3.4)

Figure 62. NDEF message management button
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3.3.3 Password management for M24SR and SRTAG products

This tool allows to manage Password and access rights.

Figure 63. Password management user interface

• READ access right commands are available:

– LOCK UNLOCK

– PERMANENT LOCK

– CHECK

• WRITE ACCESS RIGHT commands are available: 

– LOCK

– UNLOCK

– PERMANENT LOCK

– CHECK on WRITE

• CHANGE PASSWORD commands are available to change password:

– READ password

– WRITE password
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3.3.4 NFC Type 4A - NDEF Message user interface

This tool allows to read or write a NDEF file.

This user interface can manage type 2A and type 4A, type 4B, type 3, type 5 and Vicinity 
cards. It can be accessed by selecting the item in the menu.

Once the NDEF message management menu is selected, the ST25R3911B is set following 
the selected RF protocol (Configuration) and the User interface appears.

Figure 64. NFC Type 4A - NDEF message user interface

When this tool is selected, the ST25R3911B-DISCO is configured as a ISO14443-A reader. 
See the log window to know the configuration set up.

Figure 65. Log window of configuration setup
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READ NDEF MESSAGE button 

The READ NDEF message button is used to launch all the procedure to select the device 
and read the NDEF message. This whole process is described bellow.

READ NDEF MESSAGE process:

– The RF field is disabled in order to deselect the tag (RF Por).

– The RF fied is enabled.

– The Anticollision sequence is launched (ReqA, Anticol, select, RATS, PPS). The 
result is that the device is put in the NFC world.

– Select Application launched

– Read CC file process is launched (select, read length, read CC file) 
The goal is to identify NDEF file ID

– Read NDEF file process is launched (select, read length, read NDEF message)

– Decoding of NDEF message

– The available message is displayed on the screen (see Figure 66)

Figure 66. NDEF message is displayed
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This process is automatically stopped if any error or “no answer” is detected.

The Log window at the bottom of the screen will help to understand the issue in case of 
error. 

Figure 67. Log window when occur error on READ NDEF MESSAGE process

PREPARE NDEF MESSAGE 

This item will allow to create a NDEF Message with a single NDEF record or several NDEF 
record.

Notes that the NDEF message will not be written to the Tag. To be able to write the NDEF 
message to the Tag, you will need to click on WRITE NDEF MESSAGE

Figure 68. Prepare TEXT NDEF record
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Figure 69. Prepare URI NDEF record

Figure 70. Prepare SMARTPOSTER NDEF record

Figure 71. Prepare MIME VCARD NDEF record
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Figure 72. Prepare MIME BLUETOOTH PAIRING NDEF record

Figure 73. Prepare MIME MEDIA NDEF record

Figure 74. Prepare MIME VARIOUS NDEF record
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WRITE NDEF MESSAGE

Once one or more NDEF records have been selected, The user are able to write the whole 
NDEF message in the tag selecting WRITE NDEF MESSAGE ITEM. 

The user can now check NDEF message. Then click on WRITE NDEF MESSAGE to write 
it.

If the user want to change message, he can click on CLEAR then return on PREPARE 
NDEF MESSAGE to build a new one.

At the right of the window, the user will be able to prepare and write a NDEF message from 
a list of NDEF message types. 

Figure 75. Write Text NDEF message

WRITE NDEF MESSAGE process:

– The RF field is disabled in order to deselect the tag (RF Por).

– The RF fied is enabled.

– The Anticollision sequence is launched (ReqA, Anticol, select, RATS, PPS). The 
result is that the device is put in the NFC world.

– Select Application launched

– Read CC file process is launched (select, read length, read CC file) 
The goal is to identify NDEF file ID

– Write the Encoded NDEF messageThis process is automatically stopped if any 
error or “no answer” is detected. 
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The Log window at the bottom of the screen will help to understand the issue In case of 
error. 

3.4 ISO14443-B menu

This section allows to communicate with ISO14443-B tags.

Select ISO14443-B from the main menu to use the ST25R3911B-DISCO as an ISO14443-B 
reader. You can then choose between:

• ISO14443-B cards

• SO14443-B with NFC features

• SRIxx & SRT devices

Figure 76. ISO14443-B menu

Select a device from the list (see Figure 77 and Figure 78 for an example). This 
automatically configures the board as an ISO14443-B reader and displays all the 
ISO14443-B requests.

ISO14443-B communications are configured as follows:

– 106 kbits/s data rate for both transmission and reception

– CRC appended
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The ISO14443-B configuration is displayed in the log window.

The upper part of the window contains buttons allowing to send ISO14443-B requests

to tags through the ST25R3911B-DISCO antenna (refer to the device datasheet).

Select the ISO14443-B menu to launch one of the following user interface (see Figure 78):

– ISO14443-B Cards commands: (see Section 3.4.1) 
This menu allows the user to send any ISO14443-B requests

– ISO14443-B NFC commands: (see Section 3.4.2) 
This menu allows the user to send any ISO14443-B requests

– SRI512 SRT512 SRI2K SRI4K SRIX4K (see Section 3.4.3) 
This menu allows the user to send any ISO14443-B requests to SRXxx product

– NFC Type 4B NDEF Message user interface (see Section 3.4.4) 
This menu allows the user to read and write NDEF message to Tag Type 4B

3.4.1 ISO14443-B Cards commands

This window allows to communicate to any ISO14443-B card.

When selecting the ISO14443-B Card commands, the user interface is displayed, as shown 
in Figure 78

Figure 77. Example of ISO14443-B user interface
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The protocol selection is launched immediately. The summary of the commands sent to the 
ST25R3911B-DISCO are included in the log window. Click on “show log” to display it (see 
Figure 79)

Figure 78. Log file

Some basic commands are available to be able to play with ISO14443-B cards such as:

• REQB

• WPUB

• ATTRIB

Log window can be displayed by clicking on “Show log” button.

3.4.2 ISO14443-B NFC commands

Figure 79. ISO1443-B user interface
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The protocol selection is launched immediately. The summary of the commands sent to the 
ST25R3911B-DISCO are included in the log window.

This screens allow to send ISO14443-A commands:

• REQB

• WUPB

• ATTRIB

REQB & ATTRIB commands are mandatory to put the ISO14443-B NFC card into NFC 
world.

As soon as this commands have been sent successfully, you will be able to send NFC 
commands.

This commands are available on a second window. To show this window, please click on 
NFC TYPE 4B TAG button.

This window will allows to send NFC APDU in order to play with the NFC Type 4B tag.

Figure 80. ISO14443-B NFC user interface

For more informations about the use of each button, please refers to Section 3.3.2.

3.4.3 NFC Type 4B NDEF Message user interface

The functionality of this tool is the same as the NFC TYPE 4A TAG that can be found in 
ISO14443-A (see to Section 3.3.4 for more informations about how to use it).
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3.4.4 SRIxx/SRTxx products

Figure 81. Example of ISO14443-B user interface for SRIxxx

The ISO14443-B configuration is displayed in the log window as shown in figure.

The window allows to send all the command of the datasheet for this products :

– Reset to Inventory

– Initiate

– Select

– Slot Marker

– Pcall16

– Completion

– Get UID

– Read Single Block

– Read System area (address 0xFF)

– Write Single Block

– A single button allows to launch all ths Anticollision sequence.
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3.5 ISO18092 menu

1. Select ISO18092 from the main menu to use the ST25R3911B-DISCO as an ISO18092 
reader (see Figure 82).

Figure 82. ISO18092 menu

2. Select ISO18092 Cards commands from the list. This automatically configures the 
board as an ISO8092 reader and displays all the ISO18092 requests.
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The ISO18092 configuration is displayed in the log window as shown in Figure 83.

Figure 83. ISO18092 log window

Polling command can be done to communicate with an ISO18092 card. The response of the 
tag will be displayed in several fields.

ManufactureID is displayed in the second field. Click on this field to fill the Read & Write 
commands with this mandatory field.

Read command and Write command are also available.

3.6 Tools menu

Select the Tools menu to launch one of the following tools (see Figure 84):

• ST25R3911B-DISCO tool box (see Section 3.6.1: ST25R3911B-DISCO toolbox)

This menu allows the user to send requests to the ST25R3911B-DISCO.

• Script tool (see Section 3.6.2: Script tool)

This menu allows to transmit and execute a sequence of ST25R3911B-DISCO 
requests.
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Figure 84. Tools menu

3.6.1 ST25R3911B-DISCO toolbox

The toolbox allows to send the following requests to the ST25R3911B-DISCO (see 
Figure 85):

• Get MCU revision: reads the revision of the STM32 microcontroller firmware.

• Get DLL revision: reads the revision of the DLL installed on your PC.

• Field Off: turns the RF field off.

Figure 85. ST25R3911B-DISCO demonstration board toolbox 
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3.6.2 Script tool

The Script tool allows playing a script containing a sequence of ST25R3911B-DISCO 
commands (see Figure 89). The following functions are available: 

• Save Script saves the script in a text file.

• Load Script loads a script file

• Launch Script runs the script. The script is executed until an error occurs. Read the 
log to identify the cause of the error and correct your script. This can be due to a syntax 
error. Refer to the Script Help to correct it. 

• Help: display the list of commands that can be used to program the script.

Figure 86. Script help page 1/3
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Figure 87. Script help page 2/3

Figure 88. Script help page 3/3

The Script Help (see Section 3.7: Help menu) describes the syntax of all the commands that 
can be sent to the ST25R3911B-DISCO.
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Figure 89. Script tool interface

3.7 Help menu

Select the Help menu to access the following functions (see Figure 84):

• Script Help 

This function allows to get information on ST25R3911B-DISCO function syntax (see 
Figure 86, Figure 87 and Figure 88). It is particularly useful when developing a script 
(see Section 3.6.2: Script tool).

• About ...

Click About ...to get information on the ST25 Tag Editor software (see Figure 90).
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Figure 90. About window

3.8 ST25 Tag Editor RF protocol select and Send Receive 
functions formats

The ST25 Tag Editor software uses a specific format of parameters (log and script tool) for 
ST25R3911B_PROTOCOL_SELECT and ST25R3911B_SENDRECEIVE functions. (See 
below sections).

This function’s descriptions will help to understand log window and develop scripts for script 
tool. Parameter and responses formats depend on selected RF protocol. 

3.8.1 ISO15695 RF PROTOCOL

RF PROTOCOL SELECT

          

          

Script Prototype:

>>> ST25R3911B_PROTOCOL_SELECT, PARAM

<<< RESPONSE

Table 2. ISO15695 RF PROTOCOL SELECT 

Name Format Description

Input parameter PARAM
0109

ISO15693: High data rate (100%) and CRC 
calculated and added by ST25R3911B-DISCO

0108 ISO15693 High data rate(100%)

Returned 
response

RESPONSE

0000 RF protocol selected successfully

8300 Parameter error

8900 USB connection error
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SEND RECEIVE FUNCTION

          

Example: Select ISO15693 RF protocol High Data rate 100%

>>> ST25R3911B_PROTOCOL_SELECT, 0109

<<< 0000

0000: No error

Script Prototype:

>>> ST25R3911B_SENDRECEIVE, RF_REQUEST

<<< RESPONSE

Table 3. SEND RECEIVE FUNCTION 

Name Format Description

Input parameter RF_REQUEST

RF Frame 
(ex: 0220000)

ISO15693 RF REQUEST  
The CRC of RF REQUEST is calculated and added 
by ST25R3911B-DISCO

RF Frame + CRC 
(ex: 0220004750) ISO15693 RF REQUEST

Returned response RESPONSE

Error

8700 No RF response detected

8D00 RF Answer detected with collision

8A00 RF framing error

8900 USB connection error

No error: 
RF 
response 
returned

Byte 1 80 (status byte)

Byte 2 Length of output parameter

Byte 3 Byte 3 to N-1 Byte N-1 = RF Answer

Byte N Protocol error status byte (00: OK, else CRC Error)
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3.8.2 ISO14443-A RF PROTOCOL

RF PROTOCOL SELECT

          

SEND RECEIVE FUNCTION

          

Example: Read Single Block @00 

>>> ST25R3911B_SENDRECEIVE, 022000

<<< 800800E1404005FB7000

80 RF Answer OK

08 Length

00E1404005FB70 RF Response (00:flag, E1404005:Data, FB70:CRC)

00 No error

Script Prototype:

>>> ST25R3911B_PROTOCOL_SELECT, PARAM

<<< RESPONSE

Table 4. RF PROTOCOL SELECT 

Name Format Description

Input parameter PARAM 02000280 ISO14443-A Tx=106k / Rx=106k

Returned response RESPONSE

0000 RF protocol selected successfully

8300 Parameter error

8900 USB connection error

Example: Select ISO15693 RF protocol High Data rate 100%

>>> ST25R3911B_PROTOCOL_SELECT, 02000280

<<< 0000

0000: No error

Script Prototype:

>>> ST25R3911B_SENDRECEIVE, RF_REQUEST

<<< RESPONSE



DocID030328 Rev 2 81/87

UM2177 Using the ST25 Tag Editor software

85

          

Table 5. SEND RECEIVE FUNCTION 

Name Format Description

Input parameter RF_REQUEST

ISO14443-A RF 
REQUEST + CONTROL 
BYTE 
Where:

CONTROL BYTE = 0xXY

X = 0 RF frame is sent as it is.

X= 2
CRC of the RF frame is 
calculated and added to the 
RF frame sent.

Y
Number of bits of the last byte 
to be sent.

Returned 
response

RESPONSE

Error

8700 No RF response detected

8D00
RF Answer detected with 
collision

8A00 RF framing error

8900 USB connection error

No error: 
RF 
response 
returned

Byte 1 80 (status byte)

Byte 2 Length of output parameter

Byte 3 to Byte N-1 RF Answer

Byte N-2 to N
= XY ZZZZ

Protocol error 
status bytes

X = 0 CRC included in RF answer

X = 2
NO CRC included in RF 
answer

Y
Number of bits of the last 
received byte

ZZZZ = 
0000

No framing error detected in 
RF Answer
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3.8.3 ISO14443-B RF PROTOCOL

RF PROTOCOL SELECT

          

Example: REQA

>>> ST25R3911B_SENDRECEIVE, 26 07

<<< 80054200280000

80 RF Answer OK

05 Length

4200 RF Answer

280000
NO CRC included in RF answer / Last byte is 8 bits size / 
No error detected

Example: READ BINARY 5 BYTES @ 0000

>>> ST25R3911B_SENDRECEIVE, 0300B0000005FF0D 08

<<< 800D030010D1010C90006CC9080000

80 RF Answer OK

0D Length

030010D1010C90006CC9 RF Answer

080000 
CRC included in RF answer / Last byte is 8 bits size / No 
error detected

Script Prototype:

>>> ST25R3911B_PROTOCOL_SELECT, PARAM

<<< RESPONSE

Table 6. RF PROTOCOL SELECT 

Name Format Description

Input parameter PARAM 03010180
ISO14443-B: Tx=106k / Rx=106k and CRC 
calculated and added in the RF Frame to be 
sent.

Returned response RESPONSE

0000 RF protocol selected successfully

8300 Parameter error

8900 USB connection error

Example: Select ISO14443-B RF protocol Tx=106k / Rx=106k
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SEND RECEIVE FUNCTION

          

>>> ST25R3911B_PROTOCOL_SELECT, 03010180

<<< 0000

0000: No error

Script Prototype:

>>> ST25R3911B_SENDRECEIVE, RF_REQUEST

<<< RESPONSE

Table 7. SEND RECEIVE FUNCTION 

Name Format Description

Input 
parameter

RF_REQUEST - ISO14443-B RF REQUEST 

Returned 
value

RESPONSE

Error

8700 No RF response detected

8D00 RF Answer detected with collision

8A00 RF framing error

8900 USB connection error

No error: RF 
response 
returned

Byte 1 80

Byte 2 Length of output parameter

Byte 3 to Byte N-1 RF Answer

Byte N = XX Protocol error status byte
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3.8.4 ISO18092 RF PROTOCOL

RF PROTOCOL SELECT

          

Example: POLLING

>>> ST25R3911B_SENDRECEIVE, 00FFFF0000

<<< 8012010110031014111A24100B4B428485D0FF00

80 RF Answer OK

12 Length

010110031014111A24100B4B428485D0FF RF Answer

00 No error detected

Example: READ

>>> ST25R3911B_SENDRECEIVE, 06012E30B9A0D66533010900018001

<<< 801D07012E30B9A0D66533000001D220236170706C69636174696F6E2F7600

80 RF Answer OK

1D Length

07012E30B9A0D66533000001D220236170706C69636174696F6E2F76RF Answer

00 No error detected

Script Prototype:

>>> ST25R3911B_PROTOCOL_SELECT, PARAM

<<< RESPONSE

Table 8. RF PROTOCOL SELECT 

Name Format Description

Input parameter PARAM 0451100500
ISO18092-B Tx=212k Rx=212k and CRC 
calculated and added in RF 
Frame to be sent

Returned response RESPONSE

0000 RF protocol selected successfully

8300 Parameter error

8900 USB connection error

Example: Select ISO8092 RF protocol Tx=212k / Rx=212k

>>> ST25R3911B_PROTOCOL_SELECT, 0451100500

<<< 0000

0000: No error
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SEND RECEIVE FUNCTION

          

Script Prototype:

>>> ST25R3911B_SENDRECEIVE, RF_REQUEST

<<< RESPONSE

Table 9. SEND RECEIVE FUNCTION 

Name Format Description

Input 
parameter

RF_REQUEST - ISO18092: RF REQUEST 

Returned 
response

RESPONSE

Error

8700 No RF response detected

8D00 RF Answer detected with collision

8A00 RF framing error

8900 USB connection error

No error: RF 
response 
returned

Byte 1 80

Byte 2 Length of output parameter

Byte 3 to Byte N-1 RF Answer

Byte N = XX Protocol error status byte

Example: INITIATE

>>> ST25R3911B_SENDRECEIVE, 0600

<<< 8004A6443000

80 RF Answer OK

04 Length

A64430 RF Answer

00 No error detected



Revision history UM2177

86/87 DocID030328 Rev 2

4 Revision history

          

Table 10. Document revision history

Date Revision Changes

24-Mar-2017 1 Initial release.

29-Jun-2017 2

Updated:

– Introduction

– Section 2.4: ST25R3911B Discovery GUI tab

– Table 3: SEND RECEIVE FUNCTION

Added:

– Section 3: Using the ST25 Tag Editor software

– Section 3.8: ST25 Tag Editor RF protocol select and 
Send Receive functions formats
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the design of Purchasers’ products.

No license, express or implied, to any intellectual property right is granted by ST herein.

Resale of ST products with provisions different from the information set forth herein shall void any warranty granted by ST for such product.

ST and the ST logo are trademarks of ST. All other product or service names are the property of their respective owners.

Information in this document supersedes and replaces information previously supplied in any prior versions of this document.
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